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1 INTRODUCTION 
 
Congratulations and thank you for downloading/purchasing TritonEditPro 
SoundEditor for the Korg Triton synthesizer! TritonEditPro is designed to be the 
ultimate tool for organizing and creating presets for your Triton series instrument. 
Through a MIDI connection, this program can receive and transmit single 
programs, combinations, drum kits, patterns or entire Triton data. Once the 
components are transmitted to the computer, all parameters can be displayed 
and edited in a graphical user interface. The program can also be used to learn 
the inner details of the Triton architecture. Programs, combinations, patterns and 
other components can be added to libraries in user-named categories for 
creating custom banks – a terrific feature for musicians looking to organize 
patches for easy retrieval later! In addition, a genetics function is available to 
create new Triton programs simply by morphing or mutating two patches together 
into a whole new bank or using smart algorithms to achieve the best random 
patch generation results. 
 
This manual, both a user guide and handy reference, is designed to get you up 
and running quickly. 
 
We hope you enjoy using SoundEditor for your Triton synthesizer! 
 
- The Software Development Team 
 
1. 1 Credits 
Software Development: Soundtower Software, Windsor, Ontario, Canada. 
User Guide Development: Derek Prowse. 
 
1.2 Support 
Support for this product is available at: www.soundtower.com/triton 
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2 INSTALLATION/REQUIREMENTS 
 
TritonEditPro is designed to run on Windows 95/98/XP Windows 2000 and ME 
OS. 
 
With some earlier Windows ME or Windows 2000 Service pack the manual setup 
may be required. 
 
 
The TritonEditPro application requires: 
 
Pentium 100MHz (Min) 
10MB Hard Drive space 
128 MB RAM (min.). 
1024 x 768 minimum screen resolution. 
A MIDI interface 
 
The Triton firmware must be V2.0 or higher to work correctly with SoundEditor. 
Updates are available at: www.korg.com 
 
A wheeled, two–button mouse is recommended for additional control of the 
program. 
 
2.1 Before You Begin 
 
To get the most out of the TritonEditPro program you should first be familiar with 
the operation of your Triton-series instrument. The Triton-series instruments offer 
an abundance of programmable features, and the accompanying Operation 
Manual is the key resource for a complete explanation of the features and 
workings of the instrument. 
 
Although this software program can be an invaluable resource to aid in 
understanding your Triton-series instrument, it is not a substitute for reading the 
Operation Manual. 
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3 OVERVIEW 
 
This User Guide will walk you through the steps to setup TritonEditPro with your 
Triton-series instrument. The EDITORS SETUP sections should be followed first 
to get the hardware properly connected and running with the SoundEditor 
software. From there you can freely explore SoundEditor, edit and audition 
sounds, create new ones and have some fun! The Triton-series is a deep and 
complex set of instruments with many programming options. 
 
With this in mind, SoundTower editor has been designed to be as simple and 
easy to use as possible while retaining all of the functional control needed to 
adjust every single Triton parameter. 
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4 PROGRAM FLOW 
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5 SOUNDEDITOR SETUP  
 
5.1 MIDI SETUP 
Important: In order for Triton to communicate with the computer Triton's Global 
setting EXCL has to be ENA (enabled).  This setting may be reset to DIS 
automatically when you use LOAD PRESET BANKS function in Globals or load 
PCG file directly on Triton.  
 
1. Run TriEdPro.exe.  
2. From the Options menu select MIDI SETUP or press button on the toolbar: 
 

 
 
3.Select Midi IN (Triton)  and Midi OUT (Triton)  ports where Triton is physically 
connected via Midi:  
 
Note: Triton Extreme can be connected via USB port providing that USB Midi Drivers are loaded 
in the Windows system. 
 

 
 
4. Press DISABLE and ENABLE . If midi communication between the editor and 
the synthesizer is OK then Triton ROM Version will be displayed.   
 
5. If you have another Midi port with Midi Controller Keyboard hooked to it, you 
can use it to audition sounds by selecting MIDI IN (External Controller) port  and 
activating it . This feature will function properly only if there is separate port 
available on the system other than the port that synthesizer is connected to. MIDI 
In (External Keyboard) should not be set to the same Midi port as MIDI In 
(Triton). If using the Triton Keyboard for playing notes, this port should not be 
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activated. This port is intended mostly to control Korg® Triton Rack synth 
modules.   
 
6. Keyboard LOCAL ON-OFF  setting if enabled allows notes and control   
data that Triton sends when played to be send back to triton. If enabled while 
Triton’s Global setting “LOCAL” is also enabled my create unwanted results 
(double notes and etc.) 
 
  
7. Midi Channel Thru - If you use keyboard controller to play notes (other than 
Triton), the notes are played on a specific midi channel (1 - 16). If this option in 
unmarked, the editor will automatically reroute midi channel to global channel in 
Program Mode or selectable channel in combi mode. Midi Channel for playing 
and auditioning can be selected in V-Piano or by computer keys   
 
8. Triton uses Bank Map (Global Settings). It can be set to either "KORG" or 
GM/GM2. In order for the editor to switch banks correctly BANK MAP setting has 
to be matched in both in Triton and the editor.  If you fail to match those setting 
the editor will not switch from one Program/Combination bank to another. 
9. MOSS BOARD Present  – Enable is you have the optional MOSS board 
installed 
 
 
10. If the midi communication is OK then exit MIDI SETUP window. 
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5.2 RECEIVING TRITON DATA 
 
There are many options to receive data from Triton. "Receive All Data" will pull all 
Triton Internal Banks. Depending on a mode: Program, Combi, Pattern Edit or 
Drum Kit Edit, you can also request data from specific banks. "Receive" and 
"Transmit" functions are located under Midi window menu. 
Program or Combination Mode: 
 

 
 
Note: EXB banks are available only for Triton Rack and Studio models 
Pattern Edit: Triton Extreme banks are labeled with letters H… 
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Drum Kit Edit:. 
 

 
 
There is an option to receive single Program, Combi, Pattern and Drum Kit 
dumps or to request and receive whole banks at once. It is recommended to use 
Small-Single dumps to make sure that the data is transferred correctly. Triton's 
banks are very large in size and receiving big data can cause problems like byte 
loss making an incoming data corrupted and incomplete. Also some midi 
interfaces have drivers that may not handle large dumps well (MOTU).   
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(5.2 Cont’d) TRANSMITTING DATA TO TRITON 
 
The bank data Transmission to Triton has to be slowed down for Triton to 
process the incoming data. In Tri-EditPro setting time intervals between dumps 
can optimize long transmission time. Default values were tested and should work 
correctly. In case, when at the end of the transmission you see "Midi Receive 
Error" displayed on Triton's LCD, interval time should be increased. 
Sync to Triton option ensures correct transmission but is much slower since Tri-
EditPro has to wait for "received complete" signal from Triton before sending 
another data dump. 
 

 
 
  
5.3 SHORTCUTS 
  
Global Shortcut keys  
Midi Setup:                          F2 
Change to PROGRAM Mode F3 
Change to COMBINATION Mode F4 
Change to SEQUENCER Mode F5 
Global Settings Ctrl-G 
  
Mouse Piano:   F6 
Triton Continuous Control.                  Ctrl-F6 
CC Joystick Shift-F6 
  
Add Program Snap Shot (Program Mode) F7 
View Program S. Shots (Program Mode) F8 
  
Cubase Drum Map Editor Window  
Save Cubase Drum Map As...  Ctrl-S 
  
Genetics Window   
Copy selected Kid:       Ctrl-V 
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Rename Kids:    Ctrl-R 
Send To Library - > Selected Kid  Ctrl-K 
Send To Library - > All Kids Ctrl-T 
Copy Mommy’s Bank to Kids:        Ctrl-M 
 
Triton Combination Library/Triton Program Library/T riton Program MOSS 
Library  
Load Library File   Ctrl-O 
Import Combinations:     Ctrl-I 
Save:                             Ctrl-S 
Copy:                             Ctrl-C 
Paste Add:                     Ctrl-V 
Cut:                                Ctrl-X 
Delete:                            Shift+del 
 
Combination Phantom Banks/Program Phantom MOSS  Ban ks/Program 
Phantom Banks  
Load Bank Data  Ctrl-O 
Save Bank Data Ctrl-S 
Copy  Ctrl-C 
Paste Ctrl-V 
Rename Ctrl-N 
Delete Shift-del 
  
Triton Pattern Library/Triton Drum Library/Triton M FX Library  
Copy Ctrl-C 
Paste Ctrl-V 
Cut:                                Ctrl-X 
Delete Shift-del 
  
Snapshots   
Copy:                             Ctrl-C 
Paste Add Ctrl-V 
Rename:                         Ctrl-R 
  
MFX Edit Window   
Load MFX Ctrl-O 
Save Current MFX Ctrl-S 
Copy Ctrl-C 
Paste Ctrl-V 
  
Main Window  
Load All Triton Data Ctrl-L 
Save All Triton Data Ctrl-S 
Triton Banks Manager Ctrl-B 
PCG Manager Ctrl-W 
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Program Banks/Edit Window  
Copy Program Ctrl-C 
Paste Program Ctrl-V 
Initialize Program Ctrl-I 
Program Property Ctrl-P 
  
Combination Banks/Edit Window  
Copy Combination Ctrl-C 
Paste Combination Ctrl-V 
Initialize Combination Ctrl-I 
Combination Property Ctrl-P 
Display Signal Flow Ctrl-F 
Mixer Ctrl-M 
  
Sequencer Main   
Load Sequence Setup Ctrl-O 
Save Sequence Setup As Ctrl-S 
Display Signal Flow Ctrl-F 
Mixer Ctrl-M 
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6 PROGRAM BANK (PLAY) MODE 
 
6.1 PROGRAM BANK MODE 
 
Use Mode button  to switch to PROGRAM BANK MODE.  PROGRAM BANK 
MODE corresponds to Triton's PROGRAM (PLAY) mode. Since Tri-EditPro is 
fully interactive you can press PROG button on Triton and the editor will 
automatically switch to PROGRAM BANK MODE. In this mode the editor 
displays all Triton's Program banks: Internal RAM, GM and EXB. After receiving 
banks from Triton or loading the data from files, banks display all their programs 
names. In this window you can organize, rename, copy and paste or drag 
programs from one place to an other. If there is too many Program Banks to 
display in the window you can make banks to appear smaller by clicking on  
"Bank X" label or move them to the left .  
 
 In this window you choose Programs and Triton will also automatically switch to 
that Program so you can audition it or select it for editing. To select Program click 
on its name in any bank . The selected program's name should appear in name 
box .  If it does not, then check midi communication. 
 
Note: If Triton does not switch from one bank to another check Bank Map setting. 
 

 
 
There are two different ways to copy and paste programs that give great amount 
of flexibility.  
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1) By using Edit menu. From Edit menu a copied PROGRAM is copied from 
program "buffer" that is displayed in Program Name Box . The same with 
pasting, a pasted program is pasted to a "buffer" that gets displayed in the name 
box.   
 

 
 
2) By using right mouse button pop-up menu. PROGRAM is copied from program 
location. If pasted using pop-up menu, a pasted program is actually being written 
to the selected location.  
 

 
 
You can use both ways combined. For example, use Edit menu to copy current 
program as it sounds or after it was edited and then paste it to any new location 
using pop-up menu. If you loaded a bank from file, you can copy it using pop-up 
menu and then paste it using Edit menu. In this case a pasted program will not 
be written to Triton but dumped to a "buffer" so you can audition it, check it's 
sound etc. These are just simple examples. Copied Triton Program is available 
for pasting throughout the editor.   
 
Tool bar buttons  are used to request and send current Program buffer from 
Triton. Write button  displays WRITE PROGRAM dialog where you can rename 
and write the program to Triton. 
 
To prevent accidental moving of Programs in banks, an option, "Enable Drag-
Drop between banks," needs to be enabled before you can drag and drop 
Programs freely. 
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Dragging and Dropping Programs in PROGRAM BANK MODE window 
exchanges one program with an other as you can notice on pictures below 
(Gospel PercOrgan has been exchanged with MG Pulse Bass). Physical banks 
in Triton are also automatically updated with changes.  
 

 

 
 
To change "Category" of a current Program click on Category label:  
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6.2 PROGRAM GENETICS 
 
When in Program (Play) Mode enter Program Genetics by selecting Options in 
main Menu and then PROGRAM GENETICS in drop down menu . 
  

  
  
All Genetic features can be controlled from this pop-up window: 
  

 
  
On the pop-up window there are four buttons corresponding to breeding 
functions/methodologies . They are Mix, Morph, Mutate and Random:  
  

 
  
Genetics allows the user to quickly build new sounds from two existing ones in a 
similar fashion to breeding. Parameters of each of the two 
sources (parents) are combined using three different functions to generate a new 
bank of resultant sounds (kids).  
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The four functions are: 
 
Mix:  each parameter of each child is randomly chosen from either a parameter 
from the mother or father source. For example if the mother’s 
cutoff frequency was 10 and the father’s was 88, the children’s values would only 
be 10 or 88. 
 
Morph:  the value of each parameter is linearly interpolated from one parent to 
the other. The first child is identical to the mother; the last 
child is identical to the father. All others are weighted towards each parent 
depending on their placement within the list. The middle child is 
exactly ½ mother and ½ father. 
 
Mutate:  the value of each parameter of each child is randomly chosen from 
within the range between each parent’s parameter. For example if the 
mother’s cutoff frequency was 10 and the father’s was 88; the children’s values 
would be between 10 and 88…50, 25, 88, 70, 63 …etc. 
 
Random:  a random number from within the min/max voyager parameter range 
produces the value of each parameter of each child. 
The parent characteristics are imported from Program Bank A through D by 
selecting and then following the drop down menus for both Mom and Dad: 
  

 
 
The easiest way to audition results is to use computer keys and click on each 
child to hear it. If the sound is pleasing, simply drag and drop it 
in a top offspring bank ,  
  

 
  
send it to Librarian  or simply use copy and paste. 
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You can also randomly assign MFX or ARP system from Mommy to Kids by 
selecting MFX or ARP Wiz buttons : 
  

 
  
Experimentation by using vastly different parents and similar parents creates nice 
results. You can interbreed offspring too. In addition, you can set some filters . 
The excluded parameters will not take a part in generation and their values will 
be inherited from the mother.   
  

 
  
This filter option enables the editor to automatically send selected Presets in the 
Genetics window from the mother's, father's, kids' and top offspring bank to the 
edit buffer for audition. Note: characteristics of oscillators 1 and 2 can be 
individually selected out. 
Additionally, the auto write is protected  from accidentally being selected to 
prevent overwriting individual programs in program banks when send is clicked. 
 
Important: The text names are also morphed thus the strange children’s names. 
This is normal.  
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6.3 PROGRAM PHANTOM BANKS 
 
Use Mode button  to switch to PROGRAM BANK MODE or COMBINATION 

MODE. Click    to open Program Phantom Banks (PhB) window. 
 

 
 
In PhB window you can create you own bank of programs saved to your hard 
drive.  
 
In the PhB window select program bank desired by left clicking . 
 

 
 
To add PROGRAMs to selected Phantom Bank from Bank's A through GM first 
left click to select destination in panel to right. 
There are three different ways to copy and paste programs that give great 
amount of flexibility. 
 
1) By using Edit menu. From Edit menu a copied PROGRAM is copied from 
program "buffer" that is displayed in Program Name Box. The same with pasting, 
a pasted program is pasted to a "buffer" that gets displayed in the name box.  
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2) By using right mouse button pop-up menu. PROGRAM is copied from program 
location. If pasted using pop-up menu, a pasted program is actually being written 
to selected location. 
 

  
 
 3) By dragging and dropping the PROGRAM from the source bank to the 
Phantom Bank list panel. 
From  Bank Data  can be loaded or saved with file extension .tab, and 
Programs can be loaded from or copied to Program Banks A through D. 
Additionally, Phantom Banks can be populated from Genetics Top Offspring. 
 

 
 
The list can be sorted alphabetically, categorically, by Ram/Rom characteristics 
or by Pattern No. from Menu using functions found under . 
 

       
 
To clear program list for a selected Phantom Program Bank, right click on list and 
select "Clear Bank." 
 
When finished building Phantom Program Bank list use to write/send to disk. 
Add Current Program writes to selected destination the program in name box 
pre-selected in PROGRAM (PLAY) mode window. 
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6.4 PROGRAM LIBRARIAN 
 
The Librarian is a powerful program editing and organizational tool of Triton 
Sound Editor. 
 
Use Mode button  to switch to PROGRAM BANK MODE or COMBINATION 

MODE. Click    to open Triton Program Library (LIB) window. 
 

 
 
The Librarian is organized in two panels: left is a list of Program Categories , 
right is Triton Programs list . 
 

 
 
Imported Bank programs or a library is loaded by use of in Menu. Note that 
programs can be loaded from a library you have created (Ctrl+O) or from one of 
the pre-loaded Ram Program Banks A - D or from GM. 
 

  
 
Example:  
After loading a program bank, in this example Bank B , you will see all programs 
sorted by Program Category in the left panel. Any selected program category, 
here it is the Keyboard category , has it's corresponding family of programs 
listed in the right panel . In our example there are 10 programs listed under the 
Keyboard Category. 



Triton SoundEditor User Guide                           25

 

 
 
You can add programs individually from the Program (Play) mode by first 
selecting the program by clicking desired Bank and then using 
button or by dragging and dropping directly from the Program (Play) mode Bank 
list. 
 
Continuing with this example, it is a simple matter to edit a selected program 

from within Librarian. Click to enter edit mode. To edit Attack Piano from 
the Keyboard category, the program is first sent to the active buffer by clicking 

. It now resides in RAM.  
 
"Attack Piano" should be in the program Name box . 
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After editing the program to your satisfaction click button to add 
it to the Triton Programs list in right panel. It will be added at the bottom of the list 
with the same name as the original program . 
 

 
It is a simple matter to rename the file by double clicking on this entry and typing 
new name. 
 

 
 
To save the new program use "Save" or "Save Library As... ." under  in 
Menu. The Librarian files are saved the with .tlp extension. Note that Program 
Bank extension .tpb can be used when saving to Bank. When loading library 
programs note that Sysex data (.sys) is accepted as well. 
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6.5 PROGRAM LIBRARIAN 
 
The Librarian is a powerful program editing and organizational tool of Triton 
Sound Editor. Use Mode button  to switch to PROGRAM BANK MODE or 

COMBINATION MODE. Click    to open Triton Program Library (LIB) 
window. 
 

 
 
The Librarian is organized in two panels: left is a list of Program Categories , 
right is Triton Programs list . 
 

 
 
Imported Bank programs or a library is loaded by use of in Menu. Note that 
programs can be loaded from a library you have created (Ctrl+O) or from one of 
the pre-loaded Ram Program Banks A - D or from GM. 
 

  
 
Example:  
After loading a program bank, in this example Bank B , you will see all programs 
sorted by Program Category in the left panel. Any selected program category, 
here it is the Keyboard category , has it's corresponding family of programs 
listed in the right panel . In our example there are 10 programs listed under the 
Keyboard Category. 
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You can add programs individually from the Program (Play) mode by first 
selecting the program by clicking desired Bank and then using 
button or by dragging and dropping directly from the Program (Play) mode Bank 
list. 
 
Continuing with this example, it is a simple matter to edit a selected program 

from within Librarian. Click to enter edit mode. To edit Attack Piano from 
the Keyboard category, the program is first sent to the active buffer by clicking 

. It now resides in RAM.  
 
"Attack Piano" should be in the program Name box . 
 

 
 
After editing the program to your satisfaction click button to add 
it to the Triton Programs list in right panel. It will be added at the bottom of the list 
with the same name as the original program . 
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It is a simple matter to rename the file by double clicking on this entry and typing 
new name. 
 

 
 
To save the new program use "Save" or "Save Library As..." under  in 
Menu. The Librarian files are saved the with .tlp extension. Note that Program 
Bank extension .tpb can be used when saving to Bank. When loading library 
programs note that Sysex data (.sys) is accepted as well. 
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7 PROGRAM EDIT MODE 
 
7.1 PROGRAM EDIT MODE 
 

Use Mode button   to switch to PROGRAM (PLAY) MODE. Use  
 to move into Program Edit Mode. 

 

 
 
The Program Edit window is similar to the Sequencer and Combi Edit window but 
is much more involved. Functionality is the same. 
 In addition to the Sequencer and Combi Edit mode parameters of: 
 

• Common settings  
• Arp A and B  
• Master FX 1 and 2  
• Insert FX  
• Master EQ  

 
the Program Play Mode adds: 
 

• Oscillator 1 and 2  
• Amp  
• Amp EG  
• Filter  
• Filter EG  
• LFO  
• Pitch  
• Drum settings  

 
to the list. 
 
Note:  There is only one channel for Program play mode as it uses the global 
channel of the keyboard. 
 
Except for the Drum settings these are accessed by either scrolling down to the 
active part of the window or by use of the buttons  on the task bar. 
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Drum settings are accessed through the drum button found at the top 
of the window beside the oscillator selection buttons. 
 

 
 
 
SAVING PROGRAM SETTINGS 
 
If you like to save Program settings on your computer to recall for later use "Save 
Program Bank " or "Save Single Program" depending on your project. 
 

 
 
The file you save this way (with file extension *.t_p) will contain only Program 
parameter setup data.  
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LOADING PROGRAM SETTINGS 
 
Use File menu to load setting you previously had saved. 
 

 
 
 The loaded file will be displayed on editor's panels. The editor provides a flexible 
way to send saved setting to update Program. You can either send all 
parameters or single banks of parameters by using windows Midi/Transfer menu. 
 

 
 
Data can be transmitted at default intervals or changed in Transmit window as 
need after Transmit selection has been made. 
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*) The next Triton update should include copy/paste of parameter groups from/to 
Sequence, Combinations and Programs. 
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7.2 EDITING PROGRAM PARAMETERS 
 
In addition to the parameter set up common to both Combination Edit and 
Program Edit there is an additional task bar containing buttons linking to the 
controls unique to Program Edit.  
 

Use Mode button  to switch to PROGRAM (PLAY) MODE. Use  to 
move into Program Edit Mode. 
 
Except for the Drum settings these are accessed by either scrolling down to the 
active part of the window or by use of the buttons  on the task bar. 
 

 
 
Drum settings are accessed through the drum button  found at the top 
of the window beside the oscillator selection buttons. Drum Kit editing is dealt 
with in Editing Drum Kits and Drum Instrument Library tutorials. 
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OSCILLATORS 
 
There are two Oscillators available to create programs.  
 

 
 
Use the  or  buttons to select OSC 1 or OSC 1 and OSC 2. 
Clicking on the Oscillator panel will load the parameters of the selected program 
into the editing features accessed through buttons as described above (see .) 
Each oscillator has high and low multisound inputs. These are selected by 
clicking on name boxes H and L . 
 
The Oscillator Multisound window allows for selection from ROM or RAM, Sorting 
by number or Alphabetically and from file. 
 

 
 
Clicking on value boxes at  (see above) opens a separate window that allows 
for an abbreviated Osc output adjustment more fully adjusted in OSC OUTPUT 
panel found below with the AMP. 
 
When in double oscillator mode the relative levels of both oscillators can be 
adjusted to fine-tune the oscillators mix ratio. 
 
 
 
 
ARP 
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To display Arp settings click on the Arp panel: 
 

 
 
Use Arpeggiator window to change Arp settings. If you would like to edit any of 
the USER patterns, select any USER pattern (000-XXX) and click EDIT button. 
ROM patterns P00 to P04 are not editable.  
 

 
 
MFX and INSERTS  
 
You can use panel sliders to change Send or Return settings or click on  
switches to turn effects ON/OFF. 
 
By clicking on Effect panels 
 

 
 
 you can display full effect setting  of selected MFX or Insert FX. 
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The  button removes the MFX and iFX panels, leaving only the oscillator 
panels in view, from the active screen to give more working room for editing 
functions. 
 
(see Section 11: Effects for more in-depth information.) 
 
MASTER EQ 
 
Clicking the  button opens the master equalizer window. 
 

 
 
From here gain (low, mid and high), frequency (low, mid and high) as well as mid 
Q adjustment with the sliders. 
 
The choice of controller for low and high dynamic modulation is done though 

name boxes:  
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COMMON PARAMETERS 
 
To edit Common settings click  button to display Common parameters 
window: 
 

 
 
Note that Knobs 1 - 4 can be assigned to control of choice by clicking on name 
box and selecting from list. Drum kit settings can be used by clicking . 
 
PITCH EG 
 
When the  button is selected the Pitch EG window is brought into view. 
From this window all Pitch EG parameters can be adjusted. An additional feature 
is the fully interactive graphical display of parameters that allows for easy and 
instant changes of the waveform directly by the mouse. Any changes to the 
graphical display are instantly mirrored by associated slider and numerical value 
changes. AM Source Lv1, Lv2 and Tm can be changed by clicking on name 
boxes and selecting from list. Polarity switches modify polarity attributes of 
waveform (circled below.) 
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PATCH ASSIGNMENT 
 
To select a different patch for the selected track, click on the Program name. 
 

 
 
You can assign the Programs for the selected track either by using the list 
displaying Programs in banks or by a Program categories. 
 

 
 
AMP 
 

When the  button is selected the Amp panel is brought into view. From 
this panel all Amp parameters can be adjusted. The OSC OUTPUT is fully 
accessed in this panel as well . Alternative Modulation (AM) source can be 
selected by clicking on name box  as can AM for LFO 1, LFO 2 and PAN. 
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AMP EG 
 
When the  button is selected the Amp EG panel is brought into view. 
From this panel all Amp EG parameters can be adjusted. An additional feature is 
the fully interactive graphical display  of parameters that allows for easy and 
instant changes of the waveform directly by the mouse. Any changes to the 
graphical display are instantly mirrored by associated slider and numerical value 
changes. AM Source Lv1, Lv2 and Tm can be changed by clicking on name 
boxes  and selecting from list. Polarity switches  modify polarity attributes of 
waveform. 
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FILTER 
 
When the  button is selected the Filter panel is brought into view. From 
this panel all three Triton Sound Editor filter parameters can be adjusted. All AM 
sources can be changed by clicking on name boxes  and selecting from list. 
Filter type is selected from name box . 

 
 
FILTER EG 
 

When the button is selected the Filter EG panel is brought into view. 
From this panel all Filter EG parameters can be adjusted. An additional feature is 
the fully interactive graphical display  of parameters that allows for easy and 
instant changes of the waveform directly by the mouse. Any changes to the 
graphical display are instantly mirrored by associated slider and numerical value 
changes. AM Source Lv1, Lv2 and Tm can be changed by clicking on name 
boxes  and selecting from list. Polarity switches  modify polarity attributes of 
waveform. 
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LFO 1 and 2 
 
When the button is selected the LFO panel is brought into view. From 
this panel all LFO 1 and LFO 2 parameters can be adjusted. Again all AM 
sources are selected from name windows and chosen from pop-up list . 
Waveform characteristic is selected left clicking on   box list for both LFO 1 and 
LFO 2 . 

 
 
Pitch 
 
When the  button is selected the Pitch panel is brought into view. From 
this panel all Pitch related parameters can be adjusted. Again all AM sources are 
selected from name windows and chosen from pop-up list . Portamento and 
Fingered selections are turned on and off by using the  toggle. 
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7.3 PROGRAM PROPERTY WINDOW 
 
Program Property window displays basic information about current PROGRAM 
for a quick reference. Program Property is available in PROGRAM BANKS 
(PLAY) and PROGRAM EDIT modes and Triton File Manager window by 
selecting "Program Property" from either Right-button-mouse pop-up menu or 
Edit menu: 
 

 
  

 
 
 
 
 
 



Triton SoundEditor User Guide                           44

Program Property shows  
 

• Program Category.  
• Program's mode (SINGLE, DOUBLE or DRUMKIT), 
• Multisamples or RAM samples assigned.  
• Arpeggio Pattern and tempo  
• Assigned Inserts and Multi FX  

 
"USED IN COMBINATION" feature displays all combinations where this program 
is assigned. 
 
Note 1:  that this information is generated by scanning Combination Banks that 
are loaded to the TriEditPro editor if you select Program Property from editor's 
banks. For "USED IN COMBINATION" feature to be accurate use "Receive 
Banks” if you made changes in Triton without TriEditPro. 
 
Note 2:   "USED IN COMBINATION" in Program Property feature when displays 
programs from Triton File Manager scans for usage in Combination Banks 
loaded into Triton File Manager. 
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8 COMBINATION  BANK (Play) MODE 
 
8.1 COMBINATION BANK 
 
Use Mode button  to switch to COMBI BANK MODE. COMBI BANK MODE 
corresponds to Triton's COMBI (PLAY) mode. Since Tri-EditPro is fully interactive 
you can press COMBI button on Triton and the editor will automatically switch to 
COMBI BANK MODE. In this mode the editor displays all Triton's Combination 
banks, Internal RAM and EXB. After Receiving banks from Triton, or loading the 
data from files, banks display all Combinations names. In this window you can 
organize, rename, copy and paste or drag any Combination from one place to an 
other. If there is too many Banks to display in the window you can make Bank to 
appear smaller by clicking on  "Bank X" label or move them to the left . 
 In this window you choose Combinations and Triton will also automatically 
switch to selected Combination so you can audition it or select it for editing. To 
select Combination click on its name in any bank . The selected Combinations 
name should appear in name box .  If it does not, then check midi 
communication.  
 
Note: If Triton does not switch from one bank to another check Bank Map setting. 
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There are two different ways to copy and paste Combinations that give great 
amount of flexibility.  
 
1) By using Edit menu. From Edit menu a copied Combination is copied from 
program "buffer" that is displayed in Combination Name Box . The same with 
pasting, a pasted Combination is pasted to a "buffer" that gets displayed in the 
name box.   
 

 
 
2) By using right mouse button pop-up menu. Combi is copied from program 
location. If pasted using pop-up menu, a pasted program is actually being written 
to selected location.  
 

 
 
You can use both ways combined together: For example use the Edit menu to 
copy current Combination as it sounds or after it was edited and then paste it to 
any new location using pop-up menu. If you loaded a bank from file, you can 
copy it using pop-up menu and then paste it using Edit menu. In this case a 
pasted Combination will not be written to Triton but dumped to a "buffer" so you 
can audition it, check it as it sounds etc. These are just simple examples. Copied 
Triton Combination is available for pasting throughout the editor.   
Tool bar buttons  are used to request and send current Combination buffer from 
Triton. Write button  display WRITE COMBI dialog where you can rename and 
write the Combination to Triton. 
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Dragging and Dropping Combinations in COMBINATION BANK MODE window 
exchanges one Combination with another as can be seen in image below 
(Gospel PercOrgan has been exchanged with MG Pulse Bass). Physical banks 
in Triton are also automatically updated with changes.  
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8.2 PROGRAM LIBRARIAN 
 
The Librarian is a powerful program editing and organizational tool of Triton 
SoundEditor. 
 
Use Mode button  to switch to PROGRAM BANK MODE or COMBINATION 

MODE. Click    to open Triton Program Library (LIB) window. 
 

 
 
The Librarian is organized in two panels: left is a list of Program Categories , 
right is Triton Programs list . 
 

 
 
Imported Bank programs or a library is loaded by use of  in Menu. Note 
that programs can be loaded from a library you have created (Ctrl+O) or from 
one of the pre-loaded Ram Program Banks A - D or from GM. 
 

  
 
Example:  
After loading a program bank, in this example Bank B , you will see all programs 
sorted by Program Category in the left panel. Any selected program category, 
here it is the Keyboard category , has it's corresponding family of programs 
listed in the right panel . In our example there are 10 programs listed under the 
Keyboard Category. 
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You can add programs individually from the Program (Play) mode by first 
selecting the program by clicking desired Bank and then using  
button or by dragging and dropping directly from the Program (Play) mode Bank 
list. 
 
Continuing with this example, it is a simple matter to edit a selected program 

from within Librarian. Click  to enter edit mode. To edit Attack Piano from 
the Keyboard category, the program is first sent to the active buffer by clicking 

. It now resides in RAM.  
 
"Attack Piano" should be in the program Name box . 
 

 
 
After editing the program to your satisfaction click  button to add 
it to the Triton Programs list in right panel. It will be added at the bottom of the list 
with the same name as the original program . 
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It is a simple matter to rename the file by double clicking on this entry and typing 
new name. 
 

 
 
To save the new program use "Save" or "Save Library As..." under  in 
Menu. The Librarian files are saved the with .tlp extension. Note that Program 
Bank extension .tpb can be used when saving to Bank. When loading library 
programs note that Sysex data (.sys) is accepted as well. 
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8.3 PROGRAM PHANTOM BANKS 
 
Use Mode button  to switch to PROGRAM BANK MODE or COMBINATION 
MODE. Click    to open Program Phantom Banks (PhB) window. 
 

 
 
In PhB window you can create you own bank of programs saved to your hard  
drive.  
 
In the PhB window select program bank desired by left clicking . 
 

 
 
To add PROGRAMs to selected Phantom Bank from Bank's A through GM first 
left click to select destination in panel to right.  
 
There are three different ways to copy and paste programs that give great 
amount of flexibility. 
 
1) By using Edit menu. From Edit menu a copied PROGRAM is copied from 
program "buffer" that is displayed in Program Name Box. The same with pasting, 
a pasted program is pasted to a "buffer" that gets displayed in the name box.  
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2) By using right mouse button pop-up menu. PROGRAM is copied from program 
location. If pasted using pop-up menu, a pasted program is actually being written 
to selected location. 
 

  
 
 3) By dragging and dropping the PROGRAM from the source bank to the 
Phantom Bank list panel. 
 
From  Bank Data  can be loaded or saved with file extension .tpb, and 
Programs can be loaded from or copied to Program Banks A through D. 
Additionally, Phantom Banks can be populated from Genetics Top Offspring. 
 

 
 
The list can be sorted alphabetically, categorically, by Ram/Rom characteristics 
or by Pattern Number from Menu using functions found under . 
 

       
 
To clear program list for a selected Phantom Program Bank, right click on list and 
select "Clear Bank."  When finished building Phantom Program Bank list use  
to write/send to disk. 
 
Add Current Program writes to selected destination the program in name box 
pre-selected in PROGRAM (PLAY) mode window. 
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9 COMBINATION EDIT MODE 
 
9.1 COMBINATION EDIT MODE 
 

Use Mode button  to switch to COMBI MODE. Use  to move into 
Combination Edit Mode. 
 

 
 
The Combination Edit window is similar to the Sequencer Edit window. 
Functionality is also the same. Here, you can edit all Combi settings: 
 

• Common settings  
• Arp A and B  
• Master FX 1 and 2  
• Insert FX  
• Master EQ  
• All 8 Channel settings.  

 
Thanks to the latest Triton Operating System update now you can use TriEditPro 
to control Combi parameters in real time. 
 
SAVING COMBINATION SETTINGS 
 
If you like to save Combination settings on your computer to recall it later use 
"Save Combination Bank " or "Save Single Combination" from File menu option 
depending on your project. 
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The file you save this way (with file extension *.t_c) will contain only Combination 
parameter setup data.  
 
LOADING COMBINATION SETTINGS 
 
Use File menu to load setting you previously had saved. 
 

 
 
The loaded file will be displayed on Editor's panels. The Editor provides a flexible 
way to send saved setting to update Combination. You can either send all 
parameters, or single groups of parameters, by using windows Midi/Transfer 
menu. 

 
 
*) The next Triton update should include copy/paste of parameter groups from/to 
Sequence, Combinations and Programs. 
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PARAMETER LIST 
 
Under "Edit" menu you can find "Parameter List" option. We were using this 
control window for our debugging purpose. We decided to leave it and let users 
access it. It not only lists all setup parameters for viewing but it can also be used 
for a rough way of changing parameters by clicking on parameter in "Setting" 
column. Clicking the last column results in sending the current parameter setting 
as displayed without any change. The PARAMETER LIST window is also 
available in SEQUENCER Mode and in the next update it will be present in the 
Program mode. Depending on users feedback we may decide if we should add 
more functions there like print/copy/paste and etc. 
 
*) The future planned use of this window is also intended to provide access for 
reading and editing by blind musicians.  
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9.2 EDITING COMBINATION PARAMETERS 
 
COMMON PARAMETERS 
 
To edit Common settings click  button to display Common parameters 
window: 
 

 
 
MASTER EQ 
 

Clicking the  button opens the master equalizer window. 
 

 
 
From here gain (low, mid and high), frequency (low, mid and high) as well as mid 
Q adjusted with the sliders. 
 
The choice of controller for low and high dynamic modulation is done though 

name boxes:  
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ARPS 
 
To display Arp A or B settings click on the corresponding Arp panel: 
 

 
 
Use Arpeggiator window to change Arp settings. If you like to edit any the USER 
patterns, select any USER pattern (000-XXX) and click EDIT button. 
ROM patterns P00 to P04 are not editable.  
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MFX and INSERTS  
 
You can use panel sliders to change Send or Return settings or click on  
switches to turn effects ON/OFF. 
 
By clicking on Effect panels you can display full effect setting of selected MFX or 
Insert FX (see Section 11: Effects for more in-depth information): 
 

 
 
CHANNELS 
 
The grid displays all editable 8 channel/track parameters.  
 

 
 
You can change parameter values in two different ways. If your computer mouse 
is equipped with the scroll wheel, you can simply click and select any parameter 
on the grid and turn the wheel to change a value. Another way of changing 
parameters is to use mixer sliders. You can select different parameter groups 
(level, pan and etc.) from the list and all sliders will adjust themselves to 
the actual value position. You can also use the group slider to linearly adjust all 
sliders in the same time.   
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PATCH ASSIGNMENT 
 
To select a different patch for the selected track, click on the Program name. 
 

 
 
You can assign the Programs for the selected track either by using the list 
displaying Programs in banks or by a Program category 
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KEYBOARD AND VELOCITY ZONES 
 
To adjust keyboard lower and upper zone use computer mouse to drag zone 
limits: 
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9.3 COMBINATION SIGNAL FLOW 
 
The COMBINATION SIGNAL FLOW window displays 8 channel output routing. 
You can adjust all parameters that are displayed in this window. To change a 
certain parameter's value, click on a value label and use the slider . 
 

 
 
For some of the parameters the corresponding pop-up window will appear as 
they do directly in Edit Mode window. 
 
For example single click on the selected programs name in  opens the Program 
Select window. You can then change program selected to any other from any 
Combi Bank or Category. 
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Further, MFX   and MFX-Insert   functions  can be turned on or off from here or 
parameters changed with the edit windows brought up by a single click (  for 
MFX and  for MFX-Insert.) MFX direction can be changed directly by a single 
click on chain . 
 

 
 
Note: Double clicking on any of the numerical values in the value boxes allows 
the user to enter an exact value for the parameter from the keyboard. As well 
changes to the values of parameters, BUS  and iBUS , are directly mirrored 
with graphical changes to signal flow in the window. 
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9.4 COMBINATION PROPERTY POP-UP WINDOW 
 
Combination Property window displays basic information about current COMBI 
for quick reference. Combination Property is available in COMBI BANKS (PLAY), 
COMBI EDIT modes and Triton Files Manager windows by selecting 
"Combination Property" from either Right-button-mouse pop-up menu or Edit 
menu: 
 

 
 
Combination Property shows 
 

• Combination's Category.  
• Assigned Channel 1 - 8 PROGRAMS  
• Arpeggio A-B Pattern and tempo  
• Assigned Inserts and Multi FX  
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10 DRUM KIT EDITING 
 
10.1 EDITING DRUM KITS 
 

Use Mode button to switch to PROGRAM (PLAY) MODE. Use to 
move into Program Edit Mode. From here select (at this point you can 
choose a drum kit to edit from name box) and then select to enter Drum Kit 
editing mode. 
 

 
 
From Edit Mode a drum kit from Bank INT or Bank GM can be selected and 
edited or pre-selected kit edited: 
 

 
 
Using Edit in menu the selected kit can be copied and then pasted into Triton 
Drum Library for further work. (See Drum Instrument Library  tutorial for further 
information on this topic.) 
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All drum kit parameters can then be modified as desired using sliders from right 
hand panel: 
 

 
 
Scrollbar  moves the key up and down by one, use mini slider  to change by 
octave. Each change can be quickly auditioned by clicking on . 
 
Drum kit can also be loaded from saved files using File option in Menu . (Drum 
kits are saved and loaded with .t_d extension.)  
 

 
 
For information on how to make Cakewalk Drum Maps or to use the Cubase 
Drum Map Editor see tutorial modules Cubase Drum Map Editor or Cakewalk 
Instrument Definition File Generation. See Drum Instrument Library tutorial for 
use of Library function. 
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10.2 DRUM INSTRUMENT LIBRARY 
 

Use Mode button  to switch to PROGRAM (PLAY) MODE. Use  to 
move into Program Edit Mode. From here select  (at this point you can 
choose a drum kit to edit from name box) and then select  to enter Drum 
Kit editing mode. Here select .  
 
In the pop-up window one, or a selection of, drum kit(s) can be added, 
sorted, auditioned and then renamed prior to saving as a stand alone library for 
future use. 
 
To populate the library, first select a drum kit to be edited from the bank with a 
left click , copy selection with Edit in main window menu  (you will be given the 
copy option with the name of the selection noted), select Paste Add from Edit in 
library pop-up window . 
 

 
 
The program in library can be edited by drum editor functions. The edited drum 
kit can be added to the library list by clicking Add Current Drum Sound button. 
The edited drum kit sound can be renamed for saving by double clicking on the 
name and typing new name . Selecting send for any of the loaded sounds 
sends the parameters to the editing board for further work and auditioning. 
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11 EFFECTS EDITING 
 
11.1 MFX and Insert FX 
 
After right clicking on one of the MFX panel, when in Sequencer, Program Play 
Edit or Combi Play Edit Modes the full Effect panel is displayed with full effect 
settings (image below). After selecting effect from scroll box  the name should 
appear in name bar. Parameters of the effect  will be displayed with values 
associated with them to the right. 
 
All can be adjusted with the corresponding sliders by mouse or left clicking and 
then using mouse wheel.  MFX Chain signal direction can be changed by right 
clicking on MFX Chain control  and selecting direction by mousing over and left 
clicking. Corresponding MFX Chain Signal Level  and Output  are changed 
using the associated sliders. The level of effect is controlled by Level slider  by 
varying the ratio of effect from Dry (0:100 ratio => first effect to second) to Wet 
(100:0 ratio.) The Control Source is selected when name bar  is left clicked and 
Source moused over. Level is determined with corresponding slider. Note that 

the channel can be changed by mousing over clicking and then select 
channel number. 
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To Load and Save MFX files simply use File in menu and select "Load MFX" or 
"Save Current MFX As" . MFX files are saved as with .mfx extensions. 
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11.2 MFX EFFECT SYSTEM LIBRARY 
 
To access MFX Effect System Library click on button to open Library 
control panel.  
 
You can choose to load a pre-existing library of effects through File  option 

 or create one from Program Banks A through GM  or Combi Banks A, B or C 
. 

 

 
 
Send Destination is set by clicking on button to the right of Send Destination  
and mousing to desired MFX send/receive combination. 
 

 
 
If effect is to be applied to a current program from one of the Program Bank 
presets select this program by left clicking in list  and then clicking the send 
icon  .  
 
To create a library from a selected Program Bank, the selected effect from the 
Program Bank in Effect list must be selected with a left click and then either right 
click to copy or use Menu to select copy. Left click on main screen  and 
either right click and select Paste Add or use Menu . Repeat for each effect 
file desired.  
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Selected files can be sorted alphabetically through Menu . The selected 
files can be renamed by double clicking on the file name in main screen and 
typing new name . Effects are sent from the library using the  button.   
 

 
 
Save the generated Effect files through Menu  "Save File As." MFX Library 
files are saved with .lfx extension. 
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12 PATTERNS AND ARPEGGIO EDITING 
 
12.1 ARPEGGIO EDITING 
 
In Program, Combi or Sequencer Modes to display Arp settings click on the Arp 
panel (found in Edit mode for Program and Combi modes.). 
 

 
 
Use Arpeggiator window to change Arp settings. 
 

 
 
Select arpeggio pattern with left mouse click on leftmost list panel  and edit 
parameters with sliders and switches in rightmost panel . These settings modify 
overall playing characteristics of the underlying pattern of the selected arpeggio 
only.  
 
If you would like to edit any of the USER patterns, select a USER pattern (000-
XXX) and click EDIT button . When you select Edit the Pattern window will 
appear behind the Arp editing window with Pattern of selected Arpeggio loaded. 
Here you can edit each step of the pattern individually by track.  
See Pattern Editing module in tutorial for more information on editing underlying 
patterns. 
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 Note: ROM patterns P00 to P04 are not editable. 



Triton SoundEditor User Guide                           74

12.2 PATTERN EDITING 
 
To enter Arpeggio Pattern editing when in Program, Combi or Sequencer Modes 
click on the Arp panel (found in Edit mode for Program and Combi modes.) 
 

 
 
You use Arpeggiator window to change global Arp settings. To set the pattern to 
edit, select arpeggio pattern with left mouse click on leftmost panel . (To do 
basic editing of parameters use sliders and switches in rightmost panel . These 
settings modify overall playing characteristics of the underlying pattern of the 
selected arpeggio only.) To edit any of the USER patterns, select a USER 
pattern (000-XXX) and click EDIT button .  
 

 
 
The Pattern window should appear behind the Arp editing window with Pattern of 
selected Arpeggio loaded. 
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Here you can edit each step of the pattern individually by track. 
In general, the patterns are made up of from zero to 12 tracks each consisting of 
1 to 48 steps.  
 
Example: 
Having chosen pattern 001 Syn_Dittos.  
 

 
 
The number of steps used can be adjusted by resizing the step bar  by dragging 
the right most orange vertical bar. The number of steps that will be played are 
indicted on the left side of the bar. In the example above it is 16. Note though that 
this pattern actually has 17 tracks with information but the tracks selected to be 
played is less. 
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There are twelve tracks that can be potentially made active per step; Syn_Dittos 
has utilized 7.  
 
On the left most column you will see 'C4' repeated 12 times. These refer to the 
Pattern tone map. By first ensuring that the Fixed Note button is turned on: 
 

 
 
Now click on click on the 'C4' beside the desired track. This opens the Pattern 
Tone Map window. 
 

 
 

By clicking on   you are able to select from the drum kits available to 
map your pattern to. In this example we have selected '004 House Kit.' 
 

 
 
If no drum kit is desired leave tone map set to Key and the pattern can still be 
edited by track and step. 
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From the Pattern Tone Map window the kit element and key can be selected in 
two ways: 
 
1) Move the scroll bar by mouse  or 
2) select by clicking on the keyboard . 
In the main window the selection can be confirmed, or rechecked as needed, by 
mousing over the corresponding track. The selection will appear to the right of 
the cursor. In this case, track 6, E5 will read: ROM: 193 88-Conga. 
 

 
 
NOTE: the pattern being edited can be changed by clicking select pattern button 

 and choosing from the drop down window. 
 

 
 
Pitch, Gate, Velocity and Flam can be changed in two ways: 
 
1) Click on the corresponding step in the lower bar graphs and move the mouse 
to change settings. The value and step number is displayed as you move the 
mouse. In our example the Velocity was changed in Step 18 to 48. 
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Correspondingly the change is seen in the data Pitch, Gate, Velocity and Flam 
data box at the top of the window . 
 

 
 
Each of the bar graphs can be changed in the same manner. 
 
2) After one of the bars corresponding to a Step has been selected by clicking on 
it once you may change it's value with your mouse wheel or up/down arrows on 
keyboard. 
 
Type can be changed from: AS PLAYED, FILL, RUNNING UP or UP+DOWN by 
scroll bar to immediate right . 
 
For Mode to be changed between AS PLAYED or ALL TONES the Fixed Note 
switch must be ON. The scroll bar changes the Mode . 
Octave Motion is changed from UP, DOWN, BOTH and PARALLEL by again 
using scroll bar to right of label . 
 

 
 
A feature of Triton Sound Editor is the ability to phase shift one or more tracks 
step wise by using the small blue arrows on the far right of the track/step gird. 
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By clicking on the arrow the entire track moves to the right relative to non-
selected tracks: 
 

 
 
To load or save a pattern bank select File from Pattern Edit window Menu and 
then the appropriate function. The patterns are saved/loaded with .ptb extension. 
 

 
 
To Copy pattern select Edit from Pattern Edit window Menu and then Copy . 
You can later Paste to Pattern Edit Library (See Pattern Librarian module in 
tutorial for information on this function.) In Edit there is given the option of Reset 
for any of the Steps, Pitch, Velocity, Gates, or Flam parameters in a pattern  
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12.3 PATTERN LIBRARIAN 
 
The Pattern Librarian is a powerful program editing and organizational tool of 
Triton Sound Editor. 
 
To use the Pattern Librarian you need to enter Arpeggio Pattern editing when in 
Program, Combi or Sequencer Modes. Click on the Arp panel (found in Edit 
mode for Program and Combi modes.) 
 

 
 
You use Arpeggiator window to change global Arp settings. To set the pattern to 
edit select arpeggio pattern with left mouse click on leftmost list panel  (To do 
basic editing of parameters use sliders and switches in rightmost panel . These 
settings modify overall playing characteristics of the underlying pattern of the 
selected arpeggio only. See Arpeggio Editing module in tutorial for more 
information on this function.) To edit any of the USER patterns, select a USER 
pattern (000-XXX) and click EDIT button  (See Pattern Editing module in tutorial  
for more information.) 
 

 
 
The Pattern window should appear behind the Arp editing window with Pattern of 
selected Arpeggio loaded. 
 
Select library button to call up Triton Pattern Library . 
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There are several ways to load the Library with Patterns you wish to save or sort.  
1) Go to File in Menu and select Open (CTRL-O): 
 

 
 
Files are saved with and loaded from the .tpl extension. 
 
New will reset the Library. 
 
To load current pattern into Library, select and click Add Current Pattern button   
 
In the example below we had first selected Syn-Repeat then clicked Add Current 
Pattern. Secondly, loaded Str_Classical 3 into the system and clicked Add 
Current Pattern again. By selecting the Send icon associated with either of the 
two patterns that pattern is loaded to the keyboard for auditioning. 
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The program being auditioned and edited can be renamed and saved (using File 
in menu.) To rename, double-click on the text and retype . 
 

 
 
The programs added to Library can be sorted alphabetically by selecting Sort in 
the Edit drop down menu . 
 

 
 
Added programs can be individually or group deleted from list by first clicking on 
program(s) and then selecting Delete (Shift+Del) in Edit menu. Those so selected 
cannot be pasted back into memory. Select Cut from menu if you wish the 
program to be removed from Library but still be available for Paste Add. 
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13 GLOBAL SETTING EDITING 
 
13.1 GLOBAL SETTINGS 
 
Global Settings can be edited from any of: Program Play, Combi Play or 
Sequencer Modes by clicking on the button in the top tool bar.  
 

 
 
Within the Global Settings window the following is adjustable: 
Master Tune - 427.47 Hz to 452.89 Hz ; reset to 440.00Hz by clicking on  

.  
 

• Transpose - Values from: -12 to +12  
• Velocity Curve - Values from 2 to 9  
• After Touch Curve - Values from 2 to 9  
• Foot Switch Polarity - +/-  
• Damper Polarity - +/-  
• Convert Position - preMIDI/postMIDI  
• Program Auto Arp - ON/OFF  
• Combi Auto Arp - ON/OFF  
• Foot Switch Assign - Click on and choose from menu  
• Pedal Assign - Click on  and choose from menu.  

 
The Global Settings window starts with default settings. If you have different 
settings than that already in play current ones are Received by selecting on 
Send/Receive icon . 
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To reset to default values use File menu and select Initialize Global Settings . 
 

 
 
Program and Combination category names can be changed by clicking on the 
name boxes in panel to right and simply retyping the new name. 
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New settings are Sent and current ones are Received by selecting on 
Send/Receive icon . 
 
Loading and Saving Global Settings are done through File menu. Global Settings 
are save with extension .gbl. 
 

Finish by clicking on  button when satisfied. 
 
See User Scale Octave, User Scale All and Audio Input tutorial for use of these 
functions. 
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13.2 USER SCALE OCTAVE 
 
When in Global Settings window the User Scale Octave is accessed through the 

 button . 
 

 
 
Within User Scale Octave each slider key can adjust the individual values 
associated with each key within each octave . The octave to be adjusted is 
selected using the slider at the top left corner of the window . See User Scale 
All tutorial for more. 
 

 
 
When the window is closed the values are saved to the new Global Settings. 
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13.3 USER SCALE ALL  
 
When in Global Settings window the User Scale All is accessed through the 
button  .  
 

 
 
Within User Scale All each slider key can adjust window the individual values 
associated with each key within each octave . The octave to be adjusted is 
selected by clicking on the keyboard at the bottom of window . The octave that 
is being adjusted is indicated by the number in the upper left corner; in this 
example: Octave 5 . See User Scale Octave tutorial for more.  
 

 
When the window is closed the values are saved to the new Global Settings. 
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13.4 AUDIO INPUT 
 
When in Global Settings window the Audio Input controls are accessed through 
the  button . 
 

 
 
Within Audio Input the individual values associated Audio Input 1 and 2 are 
adjustable.  
 
For both inputs: 
 

• Level  
• Send 1 and 2 (to FX 1 and 2)  
• Pan and Bus selection are adjusted by sliders. 

 

 
 
When the window is closed the values are saved to the new Global Settings. 
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14 BANKS MANAGEMENT 
 
14.1 TRITON BANKS MANAGER 
 
Triton Banks Manager is a powerful organizational tool of Triton Edit Pro. Banks 
can be structured and saved in a form that is most efficient for the user. The 
Banks manager can be used to organize or check on the state of the loaded 
banks before opting to send the data to Triton and/or the Editor. This feature is 
an important safeguard to accidental overwriting of unsaved loaded programs in 
Triton RAM. 
 

Triton Bank Manager is accessed when in Program, , or Combi, , 
Modes.  From File drop down menu select Triton Banks Manager . 
 

 
 
Once in the Bank Manager window the user can elect to start New or load data in 
two ways. Load All User Banks Data or Load from a previously saved file using 
the File drop down menu. These files are saved with .tri extension. These are not 
PCG files though PCG files may be loaded.  
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Data can also be loaded from Program, Combi, Drum Kit and Pattern files 
individually by selecting the tool menu button and selecting Load Bank  from their 
respective menu. 
 

 
 
Global settings can be inserted as well from tool bar button . Select option 
from dropdown menu. 
 

 
 
All loaded Program or Combi Banks, Drum Kits, Patterns and Global Settings 
can be removed entirely through the same menu options if needs be. 
After loading the data from the selected source to Triton Bank Manager the bank 
is selected by clicking one of the tool bar buttons  causing the Manager to load 
the Program and Combi bank list for organizing. 
 

 
 
Individual programs can be copied and pasted between Program banks. By 
example, if you have selected Bank B (as in image above) you can right click on 
"A Gtr Vel Gliss," select Copy, then change banks by clicking on , this loads 
into the Program Bank list all of Bank A,  by right clicking on a list member and 
selecting Paste you will over write the program in A with "A Gtr Vel Gliss" from B. 
Note: you CANNOT copy and paste between Program Bank and Combination 
Bank list. 
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Another useful feature of the Triton Bank Manager is the Show Property function 
. Click checkbox to activate. When activated, the selection of a program in the 

Program Bank list box generates a summary of Parameters, Mode and list of 
Combinations program is used in. This will be displayed in a separate window . 
By clicking on the  portion of the window the number of 
combinations this program is used in and the list of the combination names, that 
includes channels used, is generated immediately below . 
 

 
  
To the right of Show Property, in Program (Play) Mode, is the Auto Program 
Audition feature . The program selected is automatically available in Editor for 
use. It is only available in Program Mode. 
 

 
 
The individual programs can all be renamed within the Bank Manager by double 
clicking and retyping the name . 
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TRANSMITTING DATA TO TRITON 
 
When all desired work is finished on the banks Bank Manager allows for all work 
to be sent to Sound Editor and/or Triton through the File menu  . 
 

 
 
When Transfer All to Editor is selected the program sends the reorganized banks 
to the Editor and then prompts the user with a pop up window as to weather the 
data should be sent to Triton as well. 
 

 
 
If Ok is selected the program will prompt for user to Set Intervals for transfer for 
Programs, Combinations, Drum Kits and Patterns . 
 

 
 
The bank data Transmission to Triton has to be slowed down for Triton to 
process the incoming  data. In Tri-EditPro long transmission time can be 
optimized by setting time intervals between dumps. Default values were tested 
and should work correctly. In case, when at the end of the transmission you see 
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"Midi Receive Error" displayed on Triton's LCD, interval time should be 
increased. 
 
Sync to Triton option ensures correct transmission but is much slower since Tri-
EditPro has to wait for "received complete" signal from Triton before sending 
another data dump. 
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14.2 PCG BANKS MANAGEMENT 
 
Triton PCG Manager is a powerful organizational tool of Triton Edit Pro. PCG 
files can be organized and saved in a form that is most efficient for the user. The 
PCG Manager can be used to organize or check on the state of the loaded banks 
before opting to send the data to Triton and/or the Editor. This feature is an 
important safeguard to accidental overwriting of unsaved loaded programs in 
Triton RAM. The user can essentially pick and choose the desired programs from 
a PCG bank and send only those that are needed to the editor Banks and/or 
Triton. This Management function is complementary to the Triton Bank Manager. 
The user can load an Editor bank into one of the PCG banks, cut and paste 
programs into this loaded bank and then send it back out to the Editor when 
satisfied.  
 

Triton PCG Manager is accessed when in Program   or Combi  
Modes only. From File drop down menu select Triton Banks Manager . 
 

 
 
Once in the PCG Manager window the user loads data in two ways. Select Load 
PCG File from in PCG menu . These are saved with .pcg extension. 
 

 
 
As indicated earlier, data can also be loaded from Program, Combi, Drum Kit and 
Pattern files or Editor banks individually by selecting from associated tool menu 
button and selecting Load to PCG Bank from their respective menu. 
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Global settings can be Inserted as well from tool bar button . Select option 
from dropdown menu. 
 

 
 
After loading the data from the selected source to Triton PCG Manager the bank 
is selected by clicking one of the tool bar buttons  causing the Manager to load 
the Program and Combi bank list for use. 
 

 
 
Individual programs can be copied and pasted between Program Banks. By 
example, if you have selected Bank A (as in image above) you can right click on 
"BD Grand Concert," select Copy by right clicking, then change banks by left 
clicking on , this loads into the Program Bank list all of PCG Bank B,  by right 
clicking on a list member and selecting Paste you will over write the program in A 
with "BD Grand Concert" from A. 
 
User can also paste the copied program into a bank in Editor by right clicking in 
list menu and selecting paste. In the example below the program in Bank A 
"Marcato Str Orch" is being overwritten with Paste by BD Grand Concert. 
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Note: you CANNOT copy and paste between Program Bank and Combination 
Bank list. 
 
In Program (Play) Mode the user can toggle between Auto Program Audition 
feature ON/OFF . The program selected is automatically available in Editor for 
use. It is only available in Program (PLAY) Mode. 
 

 
 
NOTE: The individual programs cannot be renamed within the PCG Manager by 
double clicking and retyping the name as can be done in Triton Bank Manager. 
 
TRANSMITTING DATA TO TRITON 
 
When all desired work is finished on the banks PCG Manager allows for all of the 
work to be sent to Sound Editor and/or Triton through the PCG dropdown menu 
. The PCG Manager allows for the newly loaded programs to be then saved as 
PCG files.  
 
NOTE: Rename the file to be saved if it is important to save originally loaded 
PCG file. Saving modified PCG banks will overwrite the existing banks in original 
file.  
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The individual banks can be saved as stand alone files when Save As, Save 
PCG Bank ... As or Save is selected from any of the dropdown menus associated 
with the following buttons  
 

 
 
When Send To is selected from any of the dropdown menus associated with the 
same buttons the program sends the selected reorganized bank to the Editor and 
then prompts the user with a pop up window as to weather the data should be 
sent to Triton as well. 
 

 
 
If Ok is selected the program will prompt for user to Set Intervals for transfer for 
Programs, Combinations, Drum Kits and Patterns . 
 

 
 
The bank data Transmission to Triton has to be slowed down for Triton to 
process the incoming  data. In Tri-EditPro long transmission time can be 
optimized by setting time intervals between dumps. Default values were tested 
and should work correctly. In case, when at the end of the transmission you see 
"Midi Receive Error" displayed on Triton's LCD, interval time should be 
increased. 
 
Sync to Triton option ensures correct transmission but is much slower since Tri-
EditPro has to wait for "received complete" signal from Triton before sending 
another data dump. 
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15 SOUND AUDITIONING   
 
 
15.1 TRIEDITPRO PC COMPUTER KEYBOARD   
 
You can play notes using your computer's keyboard. Up to 3-4 notes can be 
played at the same time.  
 
Octave Shifting:  Letters Q W E R T Y U I O P select the octave (transpose 
computer keys)  
 
Note Velocity: - and + decrease and increase note velocity  
 
Arp ON/OFF                 ~ 
 
Key/Piano Mode       numeric pad: 0=key   1=Major   2=Major(2)   3=Major7 
.del=Major7(2)  4=Minor  5=Minor(2)  6=Minor7    9=Minor7(2) 
 
Key Notes:  
  X =C 
D =C#  
  C =D  
  F =D#  
  V =E  
  B =F  
  H =F#  
  N =G  
  J  =G#  
  M =A  
  K = A#  
  , = B  
  . = C (one octave above "X" key)  
 
                 All Notes Off  -Space Bar key   
 
                      + and - = change Note velocity +/- 5  
 

and / = change Play channel +/- 1   
 

Hint:  You can “hang” a note by pressing down a “note” key and while it is 
depressed, press “octave” key.   
 
When computer keys are played value of note played is displayed together with 
channel and velocity on main window’s status bar. 
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MOUSE PIANO 
 

 
 
Mouse piano can be display or hidden using "V-Piano F3" from option menu. 
 
1 - Velocity slider adjusts velocity of notes being played. 
2 - Midi channel Slider - in Program mode Midi channel should be the same as 
Triton's Global channel. 
3 - Click right button of the mouse to show "Piano Mode" pop-up menu. You can 
play keys or select preset chords. 
4 - You can "hang" notes by dragging keys up. 
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15.2 JOYSTICK CONTROLS 
 
To change Joystick/Continuous Controller settings in any of Program, Combi or 
Sequencer modes there are two options: 
 
1) Click the  button found on the top tool bar or 
2) Go to Tools in menu and select CC Joystick  
 

 
 
From the resulting window all Joystick, or Mouse functioning as Continuous 
Controllers, values can be set. 
 

 
 
Left and Right Mouse button assignment are chosen through LM and RM drop 
down menus . 
 

 
 
 
Joystick/mouse can be toggled on or off  
 

 
 
Midi channel is easily selected from drop down menu  
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Joystick reset ON/OFF is chosen by clicking JS Auto Reset . The 
Joystick/mouse control values can be set by mousing over to grid to left and 
clicking and dragging on the screen; left mouse button is in red  and right is in 
blue . Sliders  accomplish the same effect. This example was with Auto Reset 
OFF. 
 

 
 
The two rightmost sliders are used for Pitch Blend   and After Touch control  
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16 SEQUENCER/MULTI MODE 
 
16.1 SEQUENCER MODE 
 

Use Mode button  to switch to SEQUENCER MODE.  
The Sequencer editor window is similar to the Combination Edit window. 
Functionality is also the same. Here, you can edit all sequencer song settings: 
 

• Common settings  
• Arp A and B  
• Master FX a and 2  
• Insert FX  
• Master EQ  
• 16 Channel settings.  

 
Thanks to the latest Triton Operating System update you can now use Tri-
EditPro to control Sequencer parameters in real time. The Sequencer data sent 
via MIDI can vary in size depending on how many events (notes, control data 
etc.) are recorded on sequencer tracks. The MIDI transmission of Sequencer 
data can take a quite long time: from 20 seconds to a few minutes. You can 
import your current song setup to the editor and display all setting values in 
editor's windows. 
 
To import Sequencer data you can either use "IN" button on the tool bar or the 
"Select" button.  
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Because the Sequencer data dumped to the editor can contain several Song 
setups you can select which SONG you want to work on by using the Song 
Select window: 
 

 
 
 
In this window you should type the name of the song exactly as it is displayed on 
the Triton's LCD and click "Search" button. If the sequencer data is not loaded to 
the editor you will be prompted to request and receive it from Triton. The editor 
will search for the song title in the Sequencer data and it will display the search 
result. If the title is found, it will load and show all settings in editor's graphical 
interface. 
 
COMMON PARAMETERS 
 
To edit Common settings click  button to display Common parameters 
window: 
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ARPS 
 
To display Arp A or B settings click on the corresponding Arp panel: 
 

 
 
Use Arpeggiator window to change Arp settings. If you like to edit any the USER 
patterns, select any USER pattern (000-XXX) and click EDIT button. 
 
ROM patterns P00 to P04 are not editable.  
 

 

 
See Arpeggio Editing, Pattern Editing and Pattern Librarian  modules in tutorial 
for more information. 



Triton SoundEditor User Guide                           106

MFX and INSERTS  
 
You can use panel sliders to change Send or Return settings or click on  
switches to turn effects ON/OFF. 
 
By clicking on Effect panels you can display full effect setting of selected MFX or 
Insert FX (See Effects System., and Effect Librarian. tutorial modules for more 
information.) 
 

 
 
CHANNELS 
 
The grid displays all editable 16 channel/track parameters.  
 

   
 
You can change parameter values in two different ways. If your computer mouse 
is equipped with the scroll wheel, you can simply click and select any parameter 
on the grid and turn the wheel to change a value. Another way of changing 
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parameters is to use mixer sliders. You can select different parameter groups 
(level, pan etc.) from the list and all 16 sliders will adjust themselves to the actual 
value position. You can also use the group slider to linearly adjust all 16 sliders in 
the same time.    
 
PATCH ASSIGNMENT 
 
To select a different patch for the selected track, click on the Program name. 
 

 
 
You can assign the Programs for the selected track either by using the list 
displaying Programs in banks or by a Program category. 
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KEYBOARD AND VELOCITY ZONES 
 
To adjust keyboard lower and upper zone use computer mouse to drag zone 
limits: 
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SEQUENCER SIGNAL FLOW 
 
The SEQUENCER SIGNAL FLOW window displays 16-channel output routing. 
You can adjust all parameters that are displayed in this window. To change a 
certain parameter's value, click on a value label and use the slider. 
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SAVING SEQUENCER SONG SETTINGS 
 
If you like to save Sequencer song setting on your computer to recall later or to 
create song setup templates use "Save Sequence Setup As ". 
 

 
 
The file you save this way (with file extension *.tqs) will contain only sequencer's 
parameter setup data. It will not include any track data or sequencer events.  
*) The manipulation of the whole Sysex Sequencer data dumps for a purpose of 
editing and back up may be added in the future Tri-EditPro update. 
 
LOADING SEQUENCER SONG SETTINGS 
 
Use "Load Sequence Setup" to load setting you previously had saved. The 
loaded file will be displayed on editor's panels. The editor provides a flexible way 
to send saved setting to update Sequencer Songs. User can either send all 
parameters or single groups of parameters by using windows Midi/Transfer 
menu. 
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*) The next Triton update should include copy/paste of parameter groups from/to 
Sequence, Combinations and Programs. 
  
PARAMETER LIST 
 
Under "Edit" menu user can find "Parameter List" option. We were using this 
control window for our debugging purpose. We decided to leave it and let users 
access it. It not only lists all setup parameters for viewing but it can also be used 
for a rough way of changing parameters by clicking on parameter in "Setting" 
column. Clicking the last column results in sending the current parameter setting 
as displayed without any change. The PARAMETER LIST window is also 
available in Combination Edit Mode and in the next update it will be present in 
the Program mode. Depending on users feedback we may decide if we should 
add more functions there like print/copy/paste and etc. 
 
*) The future planned use of this window is also intended to provide access for 
reading and editing by blind musicians.   
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16.2 MIXER 
 
In Triton Sound Editor Sequencer Mode click on  , 
 

 
 
to access Triton SoundEditor's full function 16 channel Sequencer mixing board.  
 

 
 
 From this window the user can adjust:  
 

• BUS Output Assignment  
• Output Level  
• Pan value  
• MFX Send 1 and 2  
• Program Select  
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as well as Master EQ and Signal Routing (See below)  
 
The Program Bank and number is displayed  directly under the Track number. 
(See Sequencer Mode tutorial for details on parameters in list above.) 
 

 
 
An added control feature for Mixer use is the inclusion of a more complete 
Sequencer Signal Flow Window situated behind the Mixer; the functionality is the 
same as the Combination Signal Flow Window . This is equivalent to the 
SEQUENCER SIGNAL FLOW window displaying all 16-channel output routing. 
The effect is the same as found in Sequencer Mode Signal Flow window (as 
described in the Sequencer Mode tutorial) but with more detailed control. 
 
The signal flow functionality is more complete in Signal Flow associated with the 
Mixer window. Control knobs replace the pop-up vertical sliders  making more 
obvious the control features and refining the action. 
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NOTE: The simpler Sequencer Mode Signal Flow is included for the User's 
convenience being that it gives a quick at-a-glance overview of the Signal Flow 
settings when in Sequencer Setup.  
 
MASTER EQ: 
 
Master EQ is include for more complete control . It is located just above the 
control features above at . The functionality is nearly identical to that found for 
Master EQ in Sequencer Setup, Program Edit or Combination Edit modes. Low 
and High Dynamic Modulation must be set from Program Edit or Combination 
Edit modes EQ. 
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17 CUBASE AND CAKEWALK SUPPORT 
 
17.1 CUBASE 5.X / SX PATCH SCRIPT GENERATION 
 
Triton-EditPro can automatically generate scripts for most popular software 
sequencers: Cubase® and Cakewalk®. 
 
To create Patch name file for Cubase 5.x use Patch View window (Under File 
menu of the main editor's window): 
 

 
 
 Patchname script should be saved into  scripts\patchnames\ folder in Cubase's 
folder. Example:  
 
C:\Program Files\Steinberg\Cubase\scripts\patchnames\  
For more information on how to set up Instruments in Cubase®, please check 
Cubase® documentation. 
 
There are two types of scripts created by Triton-EditPro depending on options 
you select: 
 
Patch Script with Triton Program and Combination Banks.  
Patch Script with Triton Program and Combination organized and displayed by 
category.  
 
All created scripts contain names of User Programs and Combinations from all 
banks that are loaded to Triton-EditPro, Program GM Bank and GM Drum Kits. 
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Patch Script with Triton Program and Combination Banks: 
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Patch Script with Triton Program and Combination organized and displayed by 
their category: 
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17.2 CUBASE DRUM MAP EDITOR 
 
You can create Cubase Drum Map with names of Triton drum sounds keys 
assigned to notes using  TriEditPro's built-in Cubase Drum Map editor. Cubase 
Drum Map editor can be Drum Kit Edit Mode. 
 
To create map select program that uses Drum Kit. 
 

 
 

Click on  button. 
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In Program Edit Window click on "Edit" Drum kit button. 
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Using File Menu select "Cubase Drum Map Editor"  
 

 
 
TriEditPro's built-in Cubase Drum Map editor can create drum maps in 3 different 
formats: 
 

• 64 notes  
• 88 notes  
• 128 Notes  
•  

Triton Drum Kit contains 128 keys so you can use whatever format is convenient 
for you. As you may notice In/Out Notes in the map are off by one octave. For 
example: note C-1 in Roland XV is equal to C-2 on Cubase. This is not a 
mistake. Korg and Cubase just named them in different ways.  
 
You can edit drum sound names, midi channel, output and velocity levels.  
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There is an option to change multiple note Midi Channel or output at once: 
 

  
 
Since Cubase midi setup (Setup MME) introduces map to midi interfaces, 
selecting output in  TriEditPro's built-in Cubase Drum Map editor is done by 
selecting number 0 to 12 where output "0" corresponds to a first/ most top 
interface in Cubase. 
 

 
You can audition/play keynotes by clicking on fields shown above.   
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17.3 CAKEWALK INSTRUMENT DEFINITION FILES 
 
Triton-EditPro can automatically generate scripts for most popular software 
sequencers: Cakewalk ® and Cubase ® . 
 
To create Instrument Definition file (.ins) for Cakewalk/Sonar use Patch View 
window (Under File menu of the main editor's window): 
 

 
 
For more information of how to set up Instruments in Cakewalk/Sonar, please 
check Cakewalk/Sonar documentation. 
 
There are two types of scripts created by Triton-EditPro depending on options 
you select: 
 
Instrument Definition for Triton Program and Combination Banks.  
Instrument Definition for Triton Drum Kit Map  
 
"Instrument Definition for Triton Program and Combination Banks" contain names 
of User Programs and Combinations from all banks that are loaded to Triton-
EditPro, Program GM Bank and GM Drum Kits. 
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Instrument Definition for Triton Program and Combination Banks: 
 

 
 
  

 
 
  



Triton SoundEditor User Guide                           125

 
 
Instrument Definition for Triton Drum Kits: 
 

 
 
To create Instrument Definition for Triton Drum Kit use file menu in DRUM KIT 
EDIT window. Created INS will contain Drum Map for selected DRUM KIT. 
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